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1 Introduction

1.1 General

This document describes the functionality of the module iPCA/SPM (iPoint Compliance Agent - Supply
Part. Management) - creation and maintenance of MDS requests for supply parts.

Information about the usage of the productsis available in the corresponding documents.

Parts of this documentation are describing optional function. These optional functions are marked as
“optional”in the documentation.

Some functions are only available with specific rights owned by the login user. If a required functionality
is not available for you, please contact your internal administrator.
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2 Support

For any questions about the application, please contact your in-house administrator.
This administrator will check and answer your enquiry.

If you in-house administrator cannot solve the problem, he will contact iPoint-systems gmbh to get a
solution for it.

Itisimportant that only the in-house administrator contacts iPoint-systems gmbh as this is the only way
to get a fast response and to avoid doing the work twice.
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3 New functions

Version Description

14.05
14.03
14.01

13.22

13.00

12.19

12.16

12.05
12.03
12.00

11.07

11.06

10.12

9.09

9.05

9.03
9.00

Added support for supplier site code (optional)

Added new tab “PDM SPM configuration parameter” in the “PDM Configuration”
parameters panel

Added “Remark” as a new search criterion

New configuration parameters to control IMDS datasheet - SPM request matching
logic

Added friendly reminder feature

Added feature that is automatically updating contacts set in the SPM request
upon they are changed/deleted in the company management or in IMDS

Bulk SPM email is now available to all SPM customers
Search criteria “from Org.unit” in “SPM” tab in the main search panel changed from
text field to list box to allow to search for SPM requests assigned to different
organization units at the same time
SPM Parameter panel extended with two new checkboxes for optional feature
allowing automatic selection of the contact person and automatic population of
the email addresses for CC email upon selection on of a supplier
New optional feature allowing automatic selection of the contact person and
automatic population of the email addresses for CC email upon selection on of a
supplier (supported for manual and automated SPM request creation)
Improved handling of languages in SPM Parameters panel
Bulk email and escalation now supports multilanguage feature
Allowed to assign MDS of different type than defined in the SPM request
New configuration parameter “SPM_FORCE_ONLINE_REQUEST” allowing to force
upload of the SPM request to the online IMDS system instead of just sending the
email to the supplier
New email notifications for two events:

e SPMrequest closure (status “Assigned MDS accepted”)

e SPM requestinactivation
Switched positions of "Edit" and "Generate" button for better user experience
New notification message on save of SPM request without an email text
Bulk SPM email functionality
New status “Marked to send email”
Redesigned SPM request form
Added new search criteria and new column into the result list
Multilanguage support
More functions can be controlled by permissions
Multi edit of SPM requests

Integration of the optional module ,Multi Number Support”
Take over IMDS-Id into email text when creating a new SPM request out of the
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m

7.5
6.0

5.4
5.2
5.01.006

51

4.06.004

4.02

“Thick Client”

Multiple email recipients as "CC”

Possibility to add attachments to the email

Take over only active contact persons

Store a corrected email address for the contact person
Suspending/Switch off the SPM reminder email

Configurable default value for search criterion “Only incomplete”

New search criteria: ID, Requestor and Sender
“Part Number Check” before save a new request

New status: “IMDS request rejected by supplier”
More flexible email sender address
Project specific email-address for escalation

New symbols for easier recognition of the different status
Availability of the full functionality in iPCA/IHS

Manual assignment of MDS

Limit own Organization Unit to a central one
Search for open, not yet sent requests
Escalation of requests

Search for requests about a specific MDS
Delete MDS

New actions when creation a request

New actions when editing a request

New additional parameter

Complete new user administration (see own documentation)
Support for IMDS Online requests
Enhanced email generation
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4 Basic terms

4.1 Short description
SPMis an optional module for acquisition and monitoring of MDS requests.
Each request is automatically monitored and its current state is displayed.

Every milestone in the lifecycle of the request is documented.

4.2 Abstract

Information about the used terms and symbols can be found in the documentation of iPCA/IHS.

10
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5 SPMrequest

5.1 Ways to create SPM request

New SPM request can be created:

manually by navigation to the menu “File > New -> Create SPM request” (see chapter 5.2),
manually by click on theicon & in the icon bar (see chapter 5.2),

manually by click on the “Create SPM Request” in the dialog window in the opened received MDS
(see chapter5.3),

automatically by BOM import (see chapter 5.4)

5.2 Create new SPM request

An empty form for SPM request creation is opened (see Figure 1).

PLEASE NOTE: Only user with activated permission “SPM” can create new SPM request.

D s5PM - Add new entry
Data || Docurnents (0)

Part-Mo.: & Project:

Recipient: Marquardt GmbH [602] j Plant: v:

MDS Type: Component - Due Date: 2019/07/30 ng;ezt EE
Sl _

upplier: PDM Supplier No: PDM -= IMDS

Supp.-Org-Unit: IMDS Company-1D:

Contact person: Contact Email:

Emnail address: Corrected Email:

Email address/es (CC):
8 Report No.:

Description Date of Report:

Drawing MNo.: Purchase Order No.:

Drawing dated: Bill of delivery Mo.:

Dr. change level: Supplier Code:

Supplier Site Code:

Email Language: x| Suspend reminders: [

Email Text: [ Generate ] [ Edit Suspend until: i
8 IMDS5 request:

Remark: Reject reason:

’ Save ] ’ Save & Send Email ] ’ Save & Send Email/ Online ] ’ Cancel

Figurel Createnew SPMrequest

11
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5.2.1 SPM details

The fields in the SPM request are sorted and split into logical areas, which could be folded and unfolded:

General (see chapter 5.2.1.1)
Supplier Data (see chapter 5.2.1.2)
Recipient Data (see chapter 5.2.1.3)
Email Data (see chapter 5.2.1.4)
Others (see chapter 5.2.1.5)

PLEASE NOTE: All non IMDS-fields in the SPM request can contain non-ASCII & 1S08859-1 characters. For
a proper functionality, the iPCA database must be on UTF8. In case the special characters are entered into
the IMDS fields in the SPM request, error message is displayed and characters are replaced with spaces.

°Illegal character in input @

! The provided text contains illegal characters. The IMDS database allows only characters from
% the ASCII- orISO8859-1 character sets.

lllegal values were replaced by spaces.

| Close | | Details = =

Figure2 Error message shown to the userin caseillegal characters were inserted

5.2.1.1 General

Following information must/could be defined:

12

Part-No.
Own part number of the item, for which the SPM request will be created.

Multi numbers

Multiple part numbers of the items, for which is applicable the SPM request, which will be created.
Before first save of the SPM request button isinactive. On save of the SPM request, the button
becomes active and multiple numbers can be defined.

This will be added also to the email text for the SPM request.

Recipient
Own organization unit, for which the SPM request will be created.

Recipient can be chosen from the drop-down list, which contains all active IMDS organization
units.

PLEASE NOTE: If “Central MDS Inbox” is option activated in the “SPM Parameter” screen, this
drop-down list is read-only so no value can be selected.

MDS Type

Type of the MDS expected to be send for anitem, for which the SPM request will be created.
MDS type can be chosen from the drop-down list, which contains following values:
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o Component
o SemiComponent
o Material

Project
The project which the item for which the SPM request will be created is linked to.

Project can be chosen using thelil button, which will load standard project search window.
Wished project can be then confirmed by click on the “Apply” button.
Projects are managed in the “Projects” master data (see chapter 7.4).

Plant

Manufacturing plant of the item, for which the SPM request will be created.
Plant can be chosen from the drop-down list.

Plants are managed in the “Plants” master data (see chapter 7.5).

Due date
Deadline given to the supplier to provide an MDS for an item, for which the SPM request will be
created.

Value is automatically set to due date = SPM request creation date + Number of days for due date
(defined in the “SPM Parameter” screen).

This can be changed either by manual modification of the date in the text field or by using
button and selecting the date from the calendar shown.

Request prelim. MDS

Information whether the preliminary MDS needs to be send for an item, for which the SPM
request will be created.

This will be added also to the email text for the SPM request.

Part-Mo.: 'S' Project: &
Recipient: j Plant; -
. . i Request prefim.
0 E Component E 201300812 i
MDS Type: p = Due date E pe

Figure3 General area of the SPM request

5.2.1.2 Supplier Data

Following information must/could be defined:

13

Supplier
Name of the IMDS company, which the SPM request will be addressed to.

The supplier can be defined by click on the lil button, which will load standard company search
window. Wished supplier can be then confirmed by click on the “Apply” button.

Supp.-Org.-Unit
Name of the organization unit of the selected supplier.
This field is read-only and cannot be modified by the user.
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Contact person
The person at the supplier to whom the requesting email will be sent.

The contact can be defined by click on the lil button, which will load the dialog window showing
all active contacts for the selected supplier. Wished contact can be then confirmed by click on the
“Apply” button.

It is also possible to correct an email of the contact by click on the “Correct” button or to define a
brand-new contact by click on the “New” button.

OPTIONAL: If the SPM Contact Priority Module is licensed and the “Auto assign primary contact”
checkboxis checked in the SPM Parameters and one contact of the selected supplier is marked as
“Primary Contact” (see chapter 7.6) then this contact is automatically selected and entered upon
selection of the supplier.

Email address

The email address of the selected contact as defined in IMDS system.

This email address can be edited or changed according to the user needs.

If the email address has been changed, on saving the SPM request, the user is asked, if the defined
email address should be saved as new email contact for the selected contact (see Figure 4).

Question @

I-e-l The email address has been changed.

¥ Do you want to save the change also to the contact masterdata as corrected email?

| Yes | | Mo

Figure 4 Question whether defined email address should be saved for selected contact

OPTIONAL: If the SPM Contact Priority Module is licensed and the “Auto assign primary contact”
checkboxis checked in the SPM Parameters and one contact of the selected supplier is marked as a
“Primary Contact” (see chapter 7.6) then email address of this contact is automatically selected
and entered upon selection of the supplier.

Email address/es (CC)
The field for definition of additional email recipients for the SPM request emails.

Multiple email addresses can be defined. They must be separated by semicolon “;”.

OPTIONAL: If the SPM Contact Priority Module is licensed and the “Auto add secondary contact(s)
as CC recipient(s)” checkbox is checked in the SPM Parameters and at least one of the contacts of
the selected supplier is marked as a “Secondary Contact” (see chapter 7.6) then email address of

this contact is automatically selected and entered upon selection of the supplier.

PDM Supplier No

If the supplier code of the supplier who should send the MDS for the item, for which the SPM
request will be created, is entered into this field and user clicks on the “PDM -> IMDS” button,
dialog window is opened (see Figure 5).
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In this dialog window, the list of all suppliers who ever used defined value as the supplier code for
any of the accepted MDS, is shown. The list is sorted by quantity of the MDS, in which the supplier
code was used.

Wished supplier can be then confirmed by click on the “Ok” button. This will take over the supplier
detailsinto the “Supplier”, “Supp.-Org-Unit” and “IMDS Company ID” fields in the SPM request.

© PDM Search [25m)
Quantity Company name  |IMDS Company-ID | Org.unit name IMDSOrg.unitID‘
1 |4
2 1
Ok I I Cancel

Figure5 List of suppliers matching defined supplier code

IMDS Company-ID

IMDS company ID of the selected supplier.
This field is read-only and cannot be modified by the user.

Contact Email

The email address of the selected contact as defined in IMDS system.
This field is read-only and cannot be modified by the user.

Corrected Email

The corrected email address of the selected contact.

This field is read-only and cannot be modified by the user. If required, this can be defined in the
contact master data.

Supplier: PDM Supplier No:
Supp.-Org-Unit; IMDS Company-I0;

Contact person: Contact Email:

Email address: Corrected Email:

Email address/es (CC):

Figure6 Supplier data area of the SPM request
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5.2.1.3 Recipient Data

Following information must/could be defined:

16

Description
Own description of the item, for which the SPM request will be created.

Drawing No.
The drawing number of the item, for which the SPM request will be created.

Drawing dated
The date of the drawing of the item, for which the SPM request will be created.

Dr. change level
The change level of the drawing of the item, for which the SPM request will be created.

Report No.
The number of the sample report of the item, for which the SPM request will be created.

Date of Report
The date of the sample report of the item, for which the SPM request will be created.

This can be defined either by manual definition of the date in the field or by using E] button and
selecting the date from the calendar shown.

Purchase Order No.
The purchase order number of the item, for which the SPM request will be created.

Bill of delivery No.
Bill of delivery number of the item, for which the SPM request will be created.

Supplier Code

The supplier code of the supplierin the PDM/ERP system of the item, for which the SPM request
will be created.

Supplier Site Code

The supplier site code of the supplier of the item, for which the SPM request will be created.
This column is shown only in case the SPM Supplier Site Code module is licensed.

Part-Mo.: Report Mo.:
Description Date of Report:
Drawing Mo.: Purchase Order No.:
Drawing dated: Bill of delivery No.:
Dr. change level: Supplier Code:

Supplier Site Code:

Figure7 Recipient data area of the SPM request
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5.2.1.4 Email data

Following information must/could be defined and used:

e Email language
The language of the email for the actual SPM request.
If no language is selected, the emails for the SPM request are sent in the default SPM language set
in the “SPM Parameter” screen.
The SPM request specific language can be chosen from the drop-down list, which contains all
languages defined in the “SPM Parameter” screen. Then, all emails for the particular SPM request,
including reminders are sent in the selected language.
In case the email text for the SPM request is already generated, language change is reflected by
click on the “Generate” button.

o Email Text

Text of the email for the SPM request could be either generated by click on the “Generate” button
or created by hand or modified by click on the “Edit” button.

In case of using email generate function the email text will be compiled from data entered in the
SPM request form and in the “SPM Parameter” screen.

e Suspend until

The sending of the email can be suspended until certain date.
This can be defined upon checking the checkbox “Suspend reminders” either by manual definition

of the date in the text field or by using button and selecting the date from the calendar shown.
Activation of this will be logged in the history of the SPM request.

Email Language: Suspend reminders:

Email Text: Generate Edit Suspend until:

Figure 8 Email data area of the SPM request

5.2.1.5 Others

Following information must/could be defined:

e Remark

Internal remarks for the SPM request can be entered into this field. This is not used for any SPM
email.

Following additional information are displayed in the SPM request form:

¢ IMDS request

If the checkbox is checked, the SPM request was successfully uploaded to live IMDS system. This is
set automatically upon the upload.
This checkbox is read-only and cannot be modified by the user.

17
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iPCA
¢ Reject reason
In this field, the reject reason, explaining why the supplier has rejected the SPM request uploaded
to live IMDS system, is shown.
This field is read-only and cannot be modified by the user.
IMDS request:
Remark: Reject reason:
Figure9 Othersarea of the SPM request
5.2.2 SPM documents

In the “Documents” tab files can be managed for the SPM request (see Figure 10). These are there
appended to the every email sent for the particular SPM request.

© SPM - Add new entry 5]

Data Documents }

File Mame | Free text field / File Mame / URL | Language

Mew Delete Show Export

[ Save ] [ Save & Send Email ] ’ Save & Send Email/ Online ] [ Cancel

Figure10 Documents tab in the SPMrequest window

Following buttons are available:

18

New

Upon clicking on this button, the dialog window is shown. By click on the button E] the target

file can be selected.
Selected file can be then added to the SPM request by click on the “Apply” button.
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o Add attachments @

Appy Cancel

Figure 11 Dialog for addition of the attachment to the SPM request

Delete

The file can be removed from the SPM request by its selection in the overview of the files and by
click on the “Delete” button.

This will bring up a small pop-up window (see Figure 12).

By click on the “Yes” button the file will be removed from the SPM request. By click on the “No”
button, the file will be kept in the SPM request.

Delete document! @

Do you really want to delete this record?

Figure12 Confirmation of deletion of a file from the SPM request

Show

The file stored in the SPM request can be displayed by first selecting it in the overview of the files
(see Figure 10) and by click on the “Show” button.

Export

The file stored in the SPM request can be exported by first selecting it in the overview of the files
(see Figure 10) and clicking on the “Export” button.

This will load a dialog window for saving the file (see Figure 13). The target directory for storage of
the document can be defined by click on the “File...” button and then by click on the “Save” button.
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o Export of documents @

Document save as...

File for gaving the export:

i

File...

(%]
=
T

Cancel

Figure 13 Dialog for exporting the file from the SPM request

5.2.3 Finishing SPM request creation
Once all details of the SPM request are defined, following buttons can be used:

e Save
Saves the SPM request in iPCA.

PLEASE NOTE: In case that the value defined in “Part-No.” field in the next SPM request is the
same as of any of existing SPM requests, a notification is shown to the user (see Figure 14). By
click on the “Yes” button the SPM request will be saved. By click on the “No” button, the SPM
request will remain opened and user can either change the part number or cancel it. In case that
the not all mandatory fields are populated an error message is shown (see Figure 15).

Warning @

! There is already an open request with same part no.
B

Do you want save the request anyway?

| Yes | | MNo |

Figure 14 Notification that new SPM request has the same part number as existing on

o Error @

lel Please fillout all mandatory fields first!

-

Figure 15 Error message shown on save of a SPMrequest
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Save & Send Email

Saves the SPM request in iPCA and sends generated email to the contact person defined in the
SPM request.

This buttonis active in case the SPM request is in one of below states:

IMDS supplier and contact person assigned

Marked to send email

Mail sent

IMDS request rejected by supplier

MDS received

Assigned MDS rejected

PLEASE NOTE: This button can be inactivated for the SPM request in state “IMDS supplier and
contact person assigned” to force the upload of the SPM request to the online IMDS system. For
this, the value of the configuration parameter “SPM_FORCE_ONLINE_REQUEST” needs to be set
to “TRUE” (see chapter 7.7 for more details).

O O O O O O

Save & Send Email/ Online

Saves the SPM request in iPCA, sends generated email to the contact person defined in the SPM
request and uploads the SPM request to the online IMDS system.

This buttonis active in case the SPM request is in one of below states:

o IMDS supplier and contact person assigned
o Marked to send email (only in case of offline SPM request)
o Mail sent (onlyin case of offline SPM request)

PLEASE NOTE: Only user with activated permission “SPM_IMDS_UPLOAD” can upload SPM
request to the online IMDS system.

Cancel
Discards changes done.

5.3 Create SPM request from existing received MDS

In case the new SPM request was created from already received MDS, the SPM request dialog window is
populated with details of this MDS.

Part number

Recipient

MDS Type

Supplier

Contact person

MDS

Complete recipient data
Email text

Email text contains also a reference to the IMDS ID of the MDS, for which the SPM request was created.

For the description of the items shown in the SPM request form, please see the chapter 5.2.1.
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PLEASE NOTE: Only user with activated permission “SPM_REQUEST_FROM_EXISTING_MDS” can create
SPM request from received MDS.

5.4 Create SPM by BOM import

In case the BOM import is done (IMDS or VP) and the configuration parameter
“PDM_CREATE_SPMREQUEST” is set to “TRUE” and matching MDS/module is not found for the part, the
SPM request with below list fields populated is created:

e Partnumber

e Recipient

e MDSType

e Supplier (in case the supplier code is set in the BOM and matching supplier was found)

e Contact person (in case the supplier code is set in the BOM and matching supplier was found)
e Email text

OPTIONAL: If the SPM Contact Priority Module is licensed and the “Auto assign primary contact”
checkboxis checked in the SPM Parameters and one contact of the selected supplier is marked as
“Primary Contact” then this contact is automatically selected. Additionally, if the “Auto add secondary
contact(s) as CC recipient(s)” checkbox is checked in the SPM Parameters and at least one of the contacts
of the selected supplier is marked as “Secondary Contact” then email address of this contact is
automatically selected and entered upon selection of the supplier.
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6 SPMtab

The SPM tabis splitinto three areas:

1. Search mask (orange) - see chapter 6.1

2. Result list (blue) - see chapter 6.2
3. Actions (green) - see chapter 6.3

iPoint

8 Search o Bl (.
SPM | »
Part-No.: Request-Date: [ Inactive too
For item no: Project: Only incomplete
Supplier: Plant: [] Only deleted
from Org.unit: - Requestor: [] Only suspended
|i‘ Sender: [] Only prelim. MDS
- 1D: Remark
MDS Type: v: Due date Indicator: |All v:
State: All - Requests: All -
[ Search ] i Reset ] @ Context menu () Filter menu
x |ID |Part number |Name |IMDS-ID |Supp|ier Supplier Code Supplier Site Code Project Plant State Type |Prelim.MDS
“ 1 *
Edit Copy Delete Historny Assign MD5
MDS Details Send email Send Online Req. | | Delete Onlin...

Figurel6 SPMtab

6.1 Search mask

Enables to search for SPM request based on defined search criteria.

The following search criteria are available:

e Part-No

Own part number of the item, for which the SPM request was created.

e Foritemno
Internal part number of the BOM.

Upon click on button, a window for search for own MDS is opened. Upon selection of an MDS
and search for SPM requests, all SPM requests existing for selected BOM are listed.
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Supplier
Company which the SPM request was addressed to.

Upon click on lil button, a company search panel is opened. Upon selection of a company and
search for SPM requests, all SPM requests existing for selected company are listed.

from Org. unit
Own organization unit(s) for which the SPM request(s) was(were) created.

MDS Type

Type of the MDS:
o Component
o SemiComponent
o Material

State
State of the SPM request:

Open requests

Requestinactive

Request acquired

IMDS supplier assigned

IMDS supplier and contact person assigned
Marked to send email

Mail sent

MDS request rejected by supplier
MDS received

Assigned MDS rejected

Assigned MDS accepted

O 0O 0O 0O 00 O o0 O O ©O

Request-Date
Period of time in which the SPM was created.

This can be defined either manually in the text field or by using
from the calendar shown.

button and selecting the date

Project
The project which the item for which the SPM request was created is linked to.

Upon click on lil button, a project search panel is opened. Upon selection of a project and search
for SPM requests, all SPM requests existing for selected project are listed.

Plant
Manufacturing plant of the item for which the SPM request was created.

Upon click on lil button, a plant search panel is opened. Upon selection of a plant and search for
SPM requests, all SPM requests existing for selected plant are listed.

Requestor
Name of the user who created the SPM request (using iPCA full name).
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Sender
Name of the user who sent the SPM request (using iPCA full name).

ID
The ID of the SPM request.

Due date indicator
An estimation, whether the SPM request can be accomplished until given due date:

o All

o Red

o Yellow

o Green

o Grey
Requests
Type of the request:

o All

All kind of SPM requests will be shown in the result list
o Only IMDS req.

Only SPM requests which were uploaded to the online IMDS system be shown in the
result list

o Only offline req.

Only SPM requests which were not uploaded to the online IMDS system be shown in the
result list

Inactive too
If this checkbox is checked, also inactive SPM requests will be shown in the result list.

Only incomplete

If this checkbox is checked, only incomplete SPM requests will be shown in the result list
PLEASE NOTE: By default, this checkbox is checked upon opening the SPM search panel. The
default value can be changed by the system administrator by setting the value of the
configuration parameter “SPM_SEARCH_DEFAULT_INCOMPLETE_ONLY” to “false” (see chapter
7.7 for more details).

Only deleted
If this checkbox is checked, only deleted SPM requests will be shown in the result list.

Only suspended

If this checkbox is checked, only SPM requests with suspended reminder will be shown in the
result list.

Only prelim. MDS

If this checkbox is checked, only SPM requests for prototype (preliminary MDS) will be shown in
theresult list.
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Remark
Remark of the SPM request.

Following actions are available:

Search
Perform searches based on criteria entered into the search fields

Reset
Remove entered search criteria from search fields.

6.2 Result list

The result list displays SPM requests as per defined search criteria. Each row represents one SPM request.

The following standard columns are available:
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ID
The ID of the SPM request.

Part Number
Own part number setin the SPM request.

Description
Value that is displayed can come from two different sources:

e SPM request without MDS assigned
Value from the field “Description” in the SPM request.

e SPM request with MDS assigned
Value from the field “Customer Description” in the “Recipient Data” tab in the received MDS.

IMDS-ID
Value that is displayed depends on whether the MDS is assigned to the SPM request or not:

e SPMrequest without MDS assigned
No value is displayed.

e SPMrequest with MDS assigned
Value is the IMDS ID and version of the assigned received MDS.

Supplier
Value that is displayed can come from two different sources:

e SPMrequest without MDS assigned
Value from the field “Supplier” in the SPM request.

e SPM request with MDS assigned
Value from the field “MDS Supplier” in the “Ingredients - IMDS” tab in the received MDS.
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Supplier Code
Value that is displayed can come from two different sources:

e SPMrequest without MDS assigned
Value from the field “Supplier Code” in the SPM request.

e SPMrequest with MDS assigned
Value from the field “Supplier Code” in the “Recipient Data” tab in the received MDS.

Supplier Site Code
Value that is displayed can come from two different sources:

e SPM request without MDS assigned
Value from the field “MDS Type:” in the SPM request.

e SPMrequest with MDS assigned

Type of the MDS of the received MDS.
This column is shown only in case the SPM Supplier Site Code module is licensed.

Project
The project set in the SPM request.

Plant
The plant setin the SPM request.

State
The actual state of the SPM request is visualized using a combination of four symbols.

Following states are available:

Request inactive

Request acquired

IMDS supplier assigned

IMDS supplier and contact person assigned
Marked to send email

Mail sent

IMDS request rejected by supplier

MDS received

¢O Request status

AMEKNEN €6 Supplier / contact
CLCOCOC O recipient status

LELE ©COrspmm
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Status

Request status

1™ Supplier / contact
™ Email status
& MDS recipient status

Assigned MDS rejected
Jd J .1 .1 Assigned MDS accepted

Table1l List of possible SPM request statuses

PLEASE NOTE: The state of the SPM request is updated on a regular base, typically every 5-15
minutes. Thisinterval can be changed in the configuration of the SPM update mission. If required,
the state of the SPM request can be started manually in the iPCA by navigation to the menu
“Extras > Update Request-State SPM”.

Type
Value that is displayed can come from two different sources:

e SPM request without MDS assigned
Value from the field “Supplier Site Code” in the SPM request.

e SPMrequest with MDS assigned
Value from the field “Supplier Site Code” in the “Recipient Data - Additional Data” tab in the
received MDS.
Prelim. MDS
Value that is displayed can come from two different sources:

e SPMrequest without MDS assigned
Value from the field “Request prelim. MDS:” in the SPM request.

e SPMrequest with MDS assigned
Value from the field “Preliminary MDS” in the “Ingredients - IMDS” tab in the received MDS.

Requested
The date of creation of the SPM request.

Received
Value that is displayed depends on whether the MDS is assigned to the SPM request or not:

e SPM request without MDS assigned
No value is displayed.
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e SPMrequest with MDS assigned
The receive date of the received MDS.

o IMDS State
Status of the IMDS online request created for the SPM request.

Following symbols are available:

J W Deleted
W New
JO sent
Working
<> Rejected
. | Waiting for acceptance

J.] Ccompleted

Table2 List of possible IMDS state statuses

e Accepted

Value that is displayed depends on whether the MDS assigned to the SPM request is accepted or
not:

e MDS assigned to the SPM request is not rejected
No value is displayed.

e MDS assigned to the SPM request is rejected
The date when assigned received MDS was accepted.

e Due-date
Due date set in the SPM request.

e Duedate

Due dateindicator for the SPM request.

The due date indicator provides a hint whether a given deadline for a SPM request can be met or
not.

Following symbols are available:

@ Deadline exceeded or not reachable
Deadline critical to be reached

.J  Deadline can be met

-] Request inactive or no deadline defined

Table3 Listof due dateindicatorstates
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Suspended
Information whether the SPM request (friendly) reminders are suspended or not.

Rejected
Value that is displayed depends on whether the MDS assigned to the SPM request is rejected or
not:
e MDS assigned to the SPM request is not rejected
No value is displayed.

e MDS assigned to the SPM request is rejected
The date when assigned received MDS was rejected.

Remark

Remark set in the SPM request.
This column is by default hidden and if wished, it can be added to the user’s search result
configuration.

PDM System

PDM System which is the source of the information used for creation of the SPM request.
This column is shown only in case the SPM ERP/PDM BOM Interface module is licensed.

PDM Client

PDM Client which is the source of the information used for creation of the SPM request.
This column is shown only in case the SPM ERP/PDM BOM Interface module is licensed.

MNS
Information if the SPM request is for multiple part numbers.

MDS MNS
Information if the datasheet assigned to the SPM request is for multiple part numbers.

The order of the columns in the result list and columns displayed can be managed by the user. For more
details see IHS user manual, chapter 29.

The content of the result list could be exported to CSV or XLS(X) format using the button .

6.3 Actions

The following actions are available:
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Edit /Show

Loads SPM request form populated with details of selected SPM request in either edit or read-only
mode (see chapter 6.3.1)

Copy
Creates a new SPM request by copying a selected SPM request (see chapter 6.3.2)
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e Delete
Deletes selected SPM request (see chapter 6.3.3)

e History
Opens history of the selected SPM request (see chapter 6.3.4)

e Assign MDS
Allows manual assignment of the MDS to the selected SPM request (see chapter 6.3.5)

e MDS Details
Loads MDS assigned to the selected SPM request (see chapter 6.3.6)

¢ Send email
Sends email to the contact person defined in the selected SPM request (see chapter 6.3.7)

¢ Send Online Request
Uploads selected SPM request to the supplier using online IMDS system (see chapter 6.3.8)

¢ Delete Online Request
Deletes selected SPM request from the online IMDS system (see chapter 6.3.9)

6.3.1 Edit /Show

Label and function of this button is interactive:

e If theuserhas write SPM permission, the label of this button is “Load”. By click, the SPM request
is loaded and depending on its state can be also edited.

e If the user hasread-only SPM permission or deleted SPM request is selected, the label of this
button is “Show”. By click, the SPM request is loaded as read-only.

The recipient specific data could be changed only until the SPM request is sent.
Once all changes are done, SPM request can be saved using one of three save buttons.

In case the supplier and/or contact and/or email address are not defined in the SPM request, an error
message (see Figure 17) is shown upon click on the button “Save & Send Email” or “Save & Send Email/
Online”.

o Error @

I:Q] Please fill out supplier, contact person and email address!

Figure 17 Error message shown onsave of a SPM request
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In case the email text is not defined in the SPM request, an error message (see Figure 18) is shown upon
click on the button “Save & Send Email” or “Save & Send Email/ Online”.

o Error @

|el Please fillout all mandatory fields first! (Ernail Text)

Figure 18 Error message shown on save of a SPM request

To cancel changes, click the “Cancel” button.
PLEASE NOTE: Only user with activated permission “SPM_EDIT” can edit SPM request.

6.3.2 Copy

A new SPM request can be created by copying an existing SPM request selected in the result table by click
on the “Copy” button. This loads a standard SPM dialog window populated with data from the original
SPM request.

On copy, following items compared to the original SPM request are changed or reset:

e Duedate

Value is set to due date = SPM request creation date + Number of days for due date (defined in the
“SPM Parameter” screen)

e Suspend reminder
Suspension of the reminder is completely removed

Once all changes are done, they can be saved by click on the “Save” button. To cancel changes, click the
“Cancel” button.

PLEASE NOTE: Only user with activated permission “SPM_COPY” can copy SPM request.

6.3.3 Delete

An existing SPM request can be deleted by click on the “Delete” button. This will bring up a small pop-up
window (see Figure 19). By click on the “Yes” button a SPM request will be deleted. By click on the “No”
button, the SPM request will be kept.

In case the SPM request was previously uploaded to the IMDS online system, the IMDS record is
automatically deleted upon the deletion of the SPM request.

PLEASE NOTE: Only user with activated permission “SPM_DELETE” can delete SPM request.
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Delete SPM request? @

Do you really want to delete this record?

| Yes | [ Mo ]

Figure19 Confirmation of deletion of a SPM request

6.3.4 History

The detailed history of the selected SPM request can be seen by click on the “History” button. This loads a
window populated with details of a SPM request (see Figure 20).

The following actions are available:

o Export
Exports the history window, e.g. to PDF format

e MDS Details
Loads MDS assigned to the SPM request

o Email-History
Opens history of all email sent for the SPM request

e Cancel
Closes the history window
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© sPm History B
Part-Mo.: Contact person:
IDMNersion Email address:
Plant: Email address/es (CC):
Project: Customer:
Recipient
PDM Supplier No:
Supplier: IMDS Company-I0:
Part-Ho.:
Description
Requested: 2013/05/28 Reguested from:
Email sent: 2013/07/24 IMDS request:
MDS received: State: ddo
MDS read: Due date Indicator: \)
Rejected:
Accepted:
Remark: History:
-
105 Details Email-History ] [ LCancel

Figure20 SPM History window

6.3.4.1 Email history

The email history displays information about all emails sent for the SPM request (see Figure 21).

The details of the email can be seen by click on the “Show email text” button (see Figure 22).

© Email-History (23]
| Mail zent Sender Subject ‘ Receivers ‘ Receivers
1 |2013/0724 - -
4 i 3
[ Show email text ] l Cancel

Figure 21 Email history window
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o 53

Target Org.-Unit:

MDS Type: Component
Customer Part No:

Customer Description:

Supplier code:

Due date: 2013005528

Cancel

Figure 22 Details of the selected email

6.3.5 Assign MDS

The MDS can be manually assigned to the selected SPM request by click on the “Assign MDS” button. This
loads a standard search window for received MDS with pre-selected type of the MDS according to the
expected type of the MDS defined in the SPM request. The MDS can be changed if the MDS provided by
the supplieris of different type than originally requested thus the MDS was not automatically matched
with the SPM request. If the MDS is found, displayed and selected in the search result list, it can be
assigned to the selected SPM request by click on the “Apply” button.

PLEASE NOTE: If an MDS was assigned to the selected SPM request, then

e Thestatus of the SPM request will be changed according to the state of the selected MDS

e Therecipient data of the SPM request will be changed to the selected MDS (if the request was
not sent yet)

e Theassociated online IMDS request will be deleted (if created)

e The MDS type defined in the SPM request will be changed to the MDS type of assigned MDS (if
MDS of different type than defined in the SPM request is chosen)

All the actions above will be logged in the history of the SPM request.
This button is active only in case the selected SPM does not have an MDS assigned to it yet.

In case that accepted MDS was assigned to the SPM request and the email notification about the SPM
request closure is enabled (see chapter 7.1.1.1 for more details), the email is created and send.

PLEASE NOTE: Only user with activated permission “SPM_ASSIGN_MDS” can assign MDS to the SPM
request.
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6.3.6 MDS Details
The MDS linked to the selected SPM request can be loaded by click on the “MDS Details” button.
This buttonis active, if the selected SPM request haw an MDS assigned to it.

PLEASE NOTE: Only user with activated permission “SPM_SHOW_MDS_DETAILS” can open the MDS
linked to the SPM request.

6.3.7 Send email

An email can be sent for an SPM request selected in the result table by click on the “Send email” button.
This will send an email to the contact person defined in the SPM request. The email generated and send
by this button is always an initial email for a selected SPM request (see chapter 8.2 for more details). The
email text can be modified using edit SPM function (see chapter 6.3.1).

This action will be logged in the history of the SPM request.
This buttonis active in case the SPM request is in one of below states:

e IMDS supplier and contact person assigned
e Marked to send email

e Mail sent

e IMDSrequest rejected by supplier

e MDS received

e Assigned MDS rejected

PLEASE NOTE: This button can be inactivated for the SPM request in state “IMDS supplier and contact
person assigned” to force the upload of the SPM request to the online IMDS system. For this, the value of
the configuration parameter “SPM_FORCE_ONLINE_REQUEST” needs to be set to “TRUE” (see chapter
7.7 for more details).

6.3.8 Send Online Request

An SPM request selected in the result table can be uploaded to online IMDS system by click on the “Send
Online Request” button. If the upload of the request is successful, the checkbox “IMDS request” in the
SPM request is checked.

This action will be logged in the history of the SPM request.
This buttonis active in case the SPM request is in one of below states:

e IMDS supplier and contact person assigned
e Marked to send email (only in case of offline SPM request)
e Mail sent (onlyin case of offline SPM request)

PLEASE NOTE: Only user with activated permission “SPM_IMDS_UPLOAD” can upload SPM request to
the online IMDS system.
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6.3.9 Delete Online Request

Anonline IMDS request for an SPM request selected in the result table can be click on the “Delete Online
Request” button. If the deletion of the request is successful, the state of the request is set to inactive.

This action will be logged in the history of the SPM request.
This button is active only if the request has already been upload to online IMDS system.

PLEASE NOTE: Only user with activated permission “SPM_IMDS_UPLOAD” can delete SPM request from
the online IMDS system.
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7 SPM configuration and master data

7.1 Parameters

7.1.1 SPM Parameter

SPM can be configured using the “SPM Parameter” screen, which is accessible from menu “Options >
Parameter > SPM Parameter”.

iPoint

(=[O =

’o SPM Parameter
GEMERAL
Default language:
Email Sender Type:
Central Email Sender:
MNumber of days for due date: =
Central MDS Inbaowx [l
Append signature:
Use only filled recipient data in email:
Send ernail about SPM request closure (Assign MDS):
Send ernail about SPM request inactivation:
Auto assign primary contact
Auto add secondary contact(s) as CC recipient(s)
Friendly Reminder:
Friendly Reminder Pericd: =
Reminder:
Reminder Pericd: %
Escalation:
Escalation Trigger: %
Escalation Receiver:
Bulk Email:
Bulk Email Interval:

( due date = creation date + x days )

Org.Unit:

days

days

. Reminder Email

-
-

hours

nEr—

-

Figure 23 SPM Parameters screen tab “GENERAL”

Save

Close

PLEASE NOTE: Only user with activated permission “ADMIN_SPM” can access SPM management.
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The SPM Parameter screen consists of:

General tab (see chapter7.1.1.1)
Language tabs (see chapter7.1.1.2)

7.1.1.1 General tab

Following information must/could be defined:
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Default language

The default language, which is used for text of SPM emails.

Language can be chosen from the drop-down list, which contains all languages defined. For the
management of the languages, please see chapter 7.1.1.1.1.
If nolanguage is selected, text of SPM emails is in English.

Email Sender Type

The email address, which is used for sending SPM emails in case the bulk email functionality is not
activated.

This option is displayed only if the email sender type feature is licensed.

Email Sender Type can be chosen from the drop-down list, which contains following values:

o Central
SPM emails are sent from the email address defined in “Central Email Sender” field

o Plant
SPM emails are sent from the email address defined for the plant assigned to the SPM
request

o Requestor
SPM emails are sent from the email address of the user who created the SPM request

Central Email Sender

The email address, which is used for sending of all SPM emails in case that “Email Sender Type” is
set to “Central”.

This option is displayed only if the central email sender feature is licensed.

Number of days for due date

Number of the days used for the calculation of the due date given to the supplier for sending the
MDS for the item requested.

Central IMDS Inbox

If the checkbox is checked, all newly created SPM request are automatically assigned to the
particular own organization unit selected from the drop-down list. Otherwise any organization
unit can be assigned to the newly created SPM request.

Append signature

If the checkbox is checked and “Email Sender Type” is set to “Requestor” and user has a signature
defined in his user profile, this signature will be appended to the SPM email. Otherwise standard
company email footer is used.
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Use only filled recipient data in email

If the checkbox is checked, only those items in the SPM request, which contain any value (are
defined) will be listed in the email text. Otherwise all items from the SPM request will be listed.

Send email about SPM request closure (Assign MDS)

If the checkbox is checked, the email notification will be sent for each SPM request set to status
“Assigned MDS accepted”.

Send email about SPM request inactivation

If the checkbox is checked, the email notification will be sent for each SPM request set to status
“Request inactive”.

Auto assign primary contact

If the checkbox is checked and one contact of the selected supplier is marked as “Primary Contact”
(see chapter 7.6) then this contact is automatically selected and entered upon selection of the
supplierin the SPM request.

This option is displayed only if the SPM Contact Priority Module is licensed.

Auto add secondary contact(s) as CC recipient(s)

If this checkbox is checked and at least one of the contacts of the selected supplier is marked as
“Secondary Contact” (see chapter 7.6) then email address of this contact is automatically selected
and entered upon selection of the supplierin the SPM request.

This option is displayed only if the SPM Contact Priority Module is licensed.

Friendly Reminder

If the checkbox is checked, friendly reminder emails will be sent for each SPM request, for which
the MDS was not provided by the supplier.

Friendly Reminder Period

The amount of days after creation of the request when the friendly reminder email will start to be
sent.

Reminder

If the checkbox is checked, reminder emails will be sent for each SPM request, for which the MDS
was not provided by the supplier.

Reminder Period

The amount of days after passing the due date for the request when the reminder email will start
to be sent.

Escalation

If the checkbox is checked, an automatic escalation takes place as soon as specific number of
reminder emails was sent for the particular SPM request.
This option is displayed only if the escalation feature is licensed.

Escalation Trigger
Number of reminder emails sent before the escalation email is sent for the particular SPM request.
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o Escalation Receiver

The email address, to which the escalation email will be send.

In case the SPM request is linked to the project with email address defined in the “Email
escalation” field, this is used instead of the email address.

This option is displayed only if the bulk email feature is licensed.

e Bulk Email
If the checkbox is checked, SPM emails will be cumulated per contact into a single email.

e Bulk Email Interval
Period in hours defining how often the bulk SPM email will be sent.

7.1.1.1.1 Languages management

SPM supports multiple languages. This means that the SPM emails can be send in different languages
based on the company preference, language of the supplier or language of their particular organization
unit. Additionally, it is also possible to set a language just for the particular SPM request.

Default company language for SPM email can be defined in “SPM Parameter” screen. This language is
used for all SPM emails and reminders unless different language is defined for:

e Company (see chapter 7.2)
e Organization Unit (see chapter 7.2)
e Particular SPM request (see chapter 5.2.1.4)

The “Languages” button in the “SPM Parameter” screen is used to manage languages for SPM emails. By
click, the dialog window is opened (see Figure 24).

o Languages @
Selection |C0untr}r Code|Language |Flag |
3 O FI Finnish = =
32 [ FJ Fiji
33 [ FO Faroese
34 | FR French "N ] 5
35 0 Fy Frisian
36 | GA Irish ']
37 ] GD Scots
38 o GL Galician
39 0 GN Guarani
40 ] Gu Gujarati
41 =l Ha Haisa %
Ok I [ Cancel

Figure 24 Languages dialog window

PLEASE NOTE: The SPM email is sent only in one particular language.

41



iPCA SPM V14.05 onwards iPoint

7.1.1.1.1.1 Addition of the new language

First, the checkbox in the first column must be checked for the selected language. This needs to be then
confirmed by click on the “Ok” button.

This will add a new language tab in the “SPM Parameters” screen. For more details about content of the
language tab, see chapter 7.1.1.2.

To confirm addition of the new language, changes must be saved by click on the “Save” buttonin the
“SPM Parameters” screen.

7.1.1.1.1.2 Removal of the language

First, the checkbox in the first column must be checked for the selected language. This needs to be then
confirmed by click on the “Ok” button.

This will remove the particular language tab from the “SPM Parameters” screen and also the language
will be removed from each opened SPM request and will be set to none.

PLEASE NOTE: It is not possible to remove language, which is set as default for the SPM emails.

OWaming @

! . The default language cannot be removed!

Figure 25 Notification to the user that default language cannot be removed

To confirm removal of the language, changes must be saved by click on the “Save” button in the “SPM
Parameters” screen.

7.1.1.2 Language tabs
In the “SPM Parameters” screen, there is one language tab per added language.
Each language tab has the same fields for which the texts may be defined:

e Email texts

e Email Subject
The subject of the SPM email.

e Closure Subject

The subject of the SPM email sent when SPM request is set to status “Assigned MDS
accepted”.

¢ Inactivation Subject
The subject of the SPM email sent when SPM request is set to status “Request inactive”.
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Email Header
The header of the initial SPM email.

Email Footer
The footer of the SPM email.

Friendly Reminder Header
The header of the friendly reminder SPM email.

Reminder Header
The header of the reminder SPM email.

Closure Header

The header of the initial SPM email sent when SPM request is set to status “Assigned MDS
accepted”.

Inactivation Header

The header of the initial SPM email sent when SPM request is set to status “Request
inactive”.

Escalation Header

The header of the escalation SPM email.
This field is displayed only if the escalation feature is licensed.

Bulk Email Header
The header of the initial bulk SPM email.

Bulk Friendly Reminder Email Header
The header of the friendly reminder bulk SPM email.

Bulk Reminder Email Header
The header of the reminder bulk SPM email.

Preliminary text
The text informing supplier that the MDS needs to be send as preliminary MDS.

Multi Numbers Text
The text informing supplier that the SPM request applies also for other items.

e Recipient labels texts

Send to Org.-Unit
Own organization unit, to which the MDS needs to be send by the supplier.

MDS Type
Type of the MDS, which needs to be send by the supplier.

Part-No
Item number, which supplier needs to use for the MDS.
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e Description
Description of the item, which supplier needs to use for the MDS.
e Drawing No.
The drawing number of the item.
e Drawingdated
The date of the drawing of the item.
e Dr.changelevel
The change level of the drawing of the item.
e Duedate
The date until the supplier is supposed to send the MDS.
¢ Report No.
The number of the sample report of the item.
¢ Date of Report
The date of the sample report of the item.
e Purchase Order No.
The purchase order number of the item.
¢ Bill of delivery No.
Bill of delivery number of the item.
e Supplier Code
The supplier code of the supplierin the PDM/ERP system of the item.
e Supplier Site Code
The supplier site code of the supplier.
This column is shown only in case the SPM Supplier Site Code module is licensed.
OSF’M’ Parameter... EIEIE
GENERAL = English |
Email Subject: .
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Email Header:

Email Footer:

Closure Subject:

Inactivation Subject:

m

Figure 26 Language tab of the SPM Parameters screen
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7.2 PDM/SPM Configuration

To manage the PDM SPM Interface configuration, panel for management needs be opened by navigation
to the menu “Options > Parameter > PDM Configuration” and then the “PDM/SPM Configuration” tab
needs to be activated.

PLEASE NOTE: This panel/tab is shown only in case the PDM SPM Interface moduleis licensed. Only user
with activated permission “ADMIN_SPM” can manage the data in the PDM configuration parameter

panel.

The panelis splitinto four areas:

1. Search panel (orange) - see chapter 7.2.1.1
2. Result list (blue) - see chapter 7.2.1.2

3. PDM SPM configuration details (green) - see chapter 7.2.1.3
4, Actions (black) - see chapter

iPoint

o PDM interface configuration =R X
[ {PDIM/SPM Configuration |
System: Client:
Systemn Mame: Client Mame:
Recipient: = | Project: %
|i| Plant:
B [ Search ] ’ Reset l @ Context menu () Filter menu
=] @‘: |System |System MName |C|ient |C|ient MName |Recipient MDS Type Project Mumber PlantId Creator |Creati0n
4| il 3
System: Client:
System Mame: Client Name:
Recipient: Project: &% |
MDS Type: Component Plant:
[__I Edit Delete Save Cancel

Figure 27 PDM interface configuration panel

7.2.1.1 Search mask

Enables to search for PDM SPM configuration based on defined search criteria.

The following search criteria are available:

e System

PDM system which is the source of the information used for creation of the SPM request.
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System Name
PDM system name which is the source of the information used for creation of the SPM request.

Recipient
Recipient used for creation of the SPM request.

MDS Type
MDS type used for creation of the SPM request.
MDS type can be chosen from the drop-down list, which contains following values:

o Component
o SemiComponent
o Material

Client
PDM client which is the source of the information used for creation of the SPM request.

Client Name
PDM client name which is the source of the information used for creation of the SPM request.

Project
Project used for creation of the SPM request.
Project can be chosen using thelil button, which will load standard project search window.

Wished project can be then confirmed by click on the “Apply” button.
Projects are managed in the “Projects” master data (see chapter 7.4).

Plant

Plant used for creation of the SPM request.

Plant can be chosen from the drop-down list.

Plants are managed in the “Plants” master data (see chapter 7.5).

The following actions are available:

Search
Perform searches based on criteria entered into the search fields.

Reset
Remove entered search criteria from search fields.

7.2.1.2 Resultlist

The result list displays PDM SPM configurations as per defined search criteria. Each row represents one
configuration.

Upon selection of the PDM SPM configuration, all its details are displayed in the PDM SPM configuration
details area below.

Following information is available:
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e System
PDM system which is the source of the information used for creation of the SPM request.

e System name
PDM system name which is the source of the information used for creation of the SPM request.

e Client
PDM client which is the source of the information used for creation of the SPM request.

e Client name
PDM client name which is the source of the information used for creation of the SPM request.

¢ Recipient
Recipient used for creation of the SPM request.

e MDS Type
MDS type used for creation of the SPM request.

e Project Number
The project number used for creation of the SPM request.

e Plantid
The plant ID used for creation of the SPM request.

e Creator
Name of the user who created the PDM SPM configuration (iPCA user name).

e Creation Date
The date of the creation of the PDM SPM configuration.

e Last Editor
Name of the user who last updated the PDM SPM configuration (iPCA user name).

e Last Change
The date when the PDM SPM configuration was last time changed by the user.

7.2.1.3 PDM SPM configuration details

Display the details of the selected PDM SPM configuration or allow definition of a PDM SPM
configuration.

7.2.1.4 Actions

The following actions are available:

e New

Empties and activates fields in the details of PDM SPM configuration area and wished PDM SPM
configuration can be defined (see chapter 7.2.1.4.1).
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Edit
Enables modification of the selected PDM SPM configuration (see chapter 7.2.1.4.2).

Delete
Deletes selected PDM SPM configuration (see chapter 7.2.1.4.3).

Save
Saves the new or updated PDM SPM configuration (see chapter 7.2.1.4.4).

Cancel
Cancels the creation or edit of the PDM SPM configuration (see chapter 7.2.1.4.5).

7.2.1.4.1 New

New PDM SPM configuration can be created by click on the “New” button.
This activates the details of PDM SPM configuration.

Following information can be defined:
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System
PDM system which is the source of the information used for creation of the SPM request.

System Name
PDM system name which is the source of the information used for creation of the SPM request.

Recipient
Recipient used for creation of the SPM request.

Recipient can be chosen from the drop-down list, which contains all active IMDS organization
units.

MDS Type
MDS type used for creation of the SPM request.
MDS type can be chosen from the drop-down list, which contains following values:

o Component
o SemiComponent
o Material

Client
PDM client which is the source of the information used for creation of the SPM request.

Client Name
PDM client name which is the source of the information used for creation of the SPM request.

Project
Project used for creation of the SPM request.

Project can be chosen using thelil button, which will load standard project search window.
Wished project can be then confirmed by click on the “Apply” button.
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Projects are managed in the “Projects” master data (see chapter 7.4).

e Plant

Plant used for creation of the SPM request.
Plant can be chosen from the drop-down list.
Plants are managed in the “Plants” master data (see chapter 7.5).

PLEASE NOTE: In case that there is already defined PDM SPM configuration for defined system and client
and error message is shown (see Figure 28) and the record is not saved.

o Error @

lgl Dataset already exists with Unique Index,

Figure 28 Error message if PDM SPM configuration already exists

PLEASE NOTE: In case that the not all mandatory fields are populated an error message is shown (see
Figure 31).

o Error @

':8] Please fillout all mandatory fields first!

-

Figure 29 Error message shown on save of a PDM SPM configuration

7.2.1.4.2 Edit
The details of the selected PDM SPM configuration can be modified by click on the “Edit” button.

Once all changes are done, they can be saved by click on the “Save” button. To cancel changes, click the
“Cancel” button.

PLEASE NOTE: In case that there is already defined PDM SPM configuration for defined system and client
and error message is shown (see Figure 28) and the record is not saved.

PLEASE NOTE: In case that the not all mandatory fields are populated an error message is shown (see
Figure 29).
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7.2.1.4.3 Delete

An existing PDM SPM configuration can be deleted upon its selection and click on the “Delete” button.
This will bring up a small pop-up window (see Figure 30). By click on the “Yes” button the PDM SPM
configuration will be deleted. By click on the “No” button, the PDM SPM configuration will be kept.

Delete @

Iﬁeﬁl Should the data really be deleted?

| Yes | | Mo |

Figure 30 Confirmation of deletion of the PDM SPM configuration

7.2.1.4.4 Save
The button is active only in case the PDM SPM configuration is being created or edited.
By click on it new or updated PDM SPM configuration is saved.

PLEASE NOTE: In case that there is already defined PDM SPM configuration for defined system and client
and error message is shown (see Figure 28) and the record is not saved.

PLEASE NOTE: In case that the not all mandatory fields are populated an error message is shown (see
Figure 29).

7.2.1.4.,5 Cancel
The buttonis active only in case the PDM SPM configuration is being created or edited.

By click on it creation or edit of the PDM SPM configuration is cancelled.

7.3 Communication language for company and organization units
A communication language can be defined on the company and/or on the organization unit level.
This language will be then used instead of the default language defined in the “SPM Parameter” screen.

If both, main company and organization unit have the language defined, the language used for the SPM
email text will be the language defined for the organization unit.

To define a communication language, company master data in iPCA needs to be opened by navigation to
the menu “Extras > Master data > Companies /legal units / contacts”. The required company needs to
be searched and edited by its selection in the result list and click on the “Edit” button.

PLEASE NOTE: Only user with activated permission “IHS_COMPANIES_MANAGEMENT_EDIT” can manage
communication language for company and/or organization unit.
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7.3.1 Definition of a language for company / organization unit

Language for the correspondence can be defined using the lil button in the field “Communication
language” in “Company data” or in “Organisation unit” tab. This loads a dialog window with languages.
Wished language can be then confirmed by click on the “OK” button.

PLEASE NOTE: In the dialog window with the languages, all existing, not only languages added in the
“SPM Parameter” screen, are shown.

To save the language defined “Save” button must be used.

7.3.2 Removal of a language for company / organization unit
Language for the correspondence can be removed using the lil buttonin the field “Communication
language” in “Company data” or in “Organisation unit” tab.

This will cause that for the next SPM emails, the company language cannot be used anymore so that the
emails will be send in the default SPM language.

PLEASE NOTE: In the dialog window with the languages, all existing, not only languages added in the
“SPM Parameter” screen, are shown.

To save the language removed “Save” button must be used.
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7.4 Projects Master Data
SPM request can be linked with the project.

iPoint

To manage the projects, panel for management of the projects in iPCA needs be opened by navigation to
the menu “Extras > Master data - Projects”.

PLEASE NOTE: Only user with activated permissions “PROJECTS_VIEW” and/or “PROJECTS_VIEW_EDIT”
can access project master data.

The panel for the management of projects is split into four areas:

1. Search mask (orange) - see chapter 7.4.1
2. Result list (blue) - see chapter chapter 7.4.2
3. Project details (green) - see chapter 7.4.3
4, Actions (black) - see chapter 7.4.4

© Projects = = &:
Project ID: Custormer name: .2
Marne:
Active:
8] : =
Search H Reset Info: 2 rows found! @ Context menu () Filter menu
EJ r
Project ID Mame Customer name | Cust,Org.Unit ID | 50P EQP Active Email Escalatiua
1
2
L
S Project ID: Customer name: &
Marne: Cust.Org.Unit ID:
SOP: | EOP: L]
Active: Ernail Escalation:
8] : -
[ Mew I I Edit Save ce Export ]

Figure31 Projects management panel

7.4.1 Search mask

Enables to search for projects based on defined search criteria.

The following search criteria are available:

e ProjectID

ID of the project.
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Name
Name of the project

Active
Checkbox defining whether the project is active or not.

Customer name
IMDS name of the customer.

Customer can be chosen using thelil button, which will load standard company search window.
Wished customer can be then confirmed by click on the “Apply” button.

The following actions are available:

Search
Perform searches based on criteria entered into the search fields

Reset
Remove entered search criteria from search fields

7.4.2 Result list

The result list displays projects as per defined search criteria. Each row represents one project.

Upon selection of the project, all its details are displayed in the project details area below.

The content of the result list could be exported to CSV or XLS(X) format using the button .

7.4.3 Project details

Display the details of the selected project or allow definition of a new project.

7.4.4 Actions

The following actions are available:
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New

Empties and activates fields in the project details area and new details of the new project can be
defined (see chapter 7.4.4.1).

Edit

Activates fields in the project details and the details can be modified (see chapter 7.4.4.2).

Save

Saves the new the project or changesin the project (see chapter 7.4.4.3).



iPCA SPM V14.05 onwards iPoint

e Cancel
Cancel the creation or edit of the project (see chapter 7.4.4.4).

o Export
Export the existing project (see chapter 7.4.4.5).

7.4.4.1 New

New project can be created by click on the “New” button.
This activates the details of project.

Following information must/could be defined:

e ProjectID

Unique ID of the project.
This field is mandatory.

¢ Name

Name of the project.
This field is mandatory.

e SOP
Start of production of the project.

¢ Active
Checkbox defining whether the project is active or not.

e Customer name
IMDS name of the customer.

Customer can be chosen using the lil button, which will load standard company search window.
Wished customer can be then confirmed by click on the “Apply” button.

e Cust.Org.UnitID
IMDS organization unit of the selected customer.

e EOP
End of production of the project.

o Email Escalation

Email address, which should be used for the escalation email instead of the default escalation
email defined in the “SPM Parameter” screen.
For details about the escalation email, see chapter 8.2.2.
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7.4.4.2 Edit

All the details of the selected project except for the “Project ID” can be modified by click on the “Edit”
button.

Once all changes are done, project can be saved by click on the “Save” button. To cancel changes, click the
“Cancel” button.

7.4.4.3 Save
The buttonis active only in case the project is being created or edited.

By click on it new or updated project is saved.

PLEASE NOTE: In case that the not all mandatory fields are populated an error message is shown (see
Figure 32).

o Error @

':8] Please fillout all mandatory fields first!

Figure32 Error message shown on save of a project

7.4.4.4 Cancel
The buttonis active only in case the project is being created or edited.

By click on it creation or edit of the project is cancelled.

7.4.4.5 Export
The content of the result list could be exported to CSV or XLS(X) format by click on the “Export” button.

The useris then asked to choose a desired output format and define the location, where the exported file
is to be stored. To learn more details about export function, please see the IHS user manual (see chapter
6.4.4).
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7.5 Plants Master Data
SPM request can be linked with the plant.

Panel for management of the plantsin iPCA can be opened by navigation to the menu “Extras -> Master
data > Projects”.

PLEASE NOTE: Only user with activated permissions “PLANTS_VIEW” and/or “PLANTS _VIEW_EDIT” can
access plants master data.

The panel management of the plants is split into three areas:
1. Overview of plants (orange) - see chapter 7.5.1

2. Plant details (blue) - see chapter 7.5.2
3. Actions(green)-see chapter7.5.3

(© Plants =5 o )
(-]
Plant-ID Name Short name | Active Org.Unit-ID | Email Sender
1
2
E] 8 '
Plant-10:
Name:
Short name:
Org.Unit.-kd:
Email Sender:
Active:
\ J
8 ’ Hew |[ Edit | Save Cance

Figure 33 Plants management panel

7.5.1 Overview of plants

The list of plants is shown upon load of the plants management panel. Upon selection of the plant, all its
details are displayed in the plant details area below.
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7.5.2 Plant details

Following information must/could be defined:

Plant-ID
Unique ID of the plant. This field is mandatory.

Name
Name of the plant. This field is mandatory.

Short name

Short name (code) of the plant.

Org.Unit-Id

IMDS organization unit related to the plant.

Thisis used for the translation of the plant code in the standard iPCA BOM to the own
organization unit so that the MDS created by the IMDS of the BOM is assigned accordingly.
Email sender

The email address, which should be used for submission of the SPM email assigned to the plant.

Active
Checkbox defining whether the plant is active or not.

7.5.3 Actions

The following actions are available:

New

Empties and activates fields in the plant details area and new details of the new plant can be
defined (see chapter 7.5.3.1).

Edit

Activates fields in the plant details and the details can be modified (see chapter 7.5.3.2).
PLEASE NOTE: Plant- ID cannot be changed

Save
Saves the new the plant or changesin the plant (see chapter 7.5.3.3).

Cancel
Cancel the creation or edit of the plant (see chapter 7.5.3.4).

Export
Export the existing plants (see chapter 7.5.3.5).

7.5.3.1 New

New plant can be created by click on the “New” button.
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This activates the details of plant.

Following information must/could be defined:

Plant-ID

Unique ID of the plant.
This field is mandatory.

Name

Name of the plant.
This field is mandatory.

Short name
Short name of the plant.

Org.Unit.-Id
IMDS organization unit related to the plant.

Thisis used for the translation of the plant code in the standard iPCA BOM to the own
organization unit so that the MDS created by the IMDS of the BOM is assigned accordingly.

Email Sender

Email address, which should be used for the escalation email instead of the default escalation
email defined in the “SPM Parameter” screen.

Active
Checkbox defining whether the plant is active or not.

7.5.3.2 Edit

All the details of the selected plant except for the “Plant-ID” can be modified by click on the “Edit”
button.

Once all changes are done, plant can be saved by click on the “Save” button. To cancel changes, click the
“Cancel” button.

7.5.3.3 Save

The button is active only in case the plant is being created or edited.

By click on it new or updated plant is saved.

PLEASE NOTE: In case that the not all mandatory fields are populated an error message is shown (see
Figure 34).
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o Error @

|8l Please fillout all mandatory fields first!

Figure 34 Error message shown onsave of a plant

7.5.3.4 Cancel
The buttonis active only in case the plant is being created or edited.

By click on it creation or edit of the plant is cancelled.

7.5.3.5 Export
The content of the result list could be exported to CSV or XLS(X) format by click on the “Export” button.

The user is then asked to choose a desired output format and define the location, where the exported file
is to be stored. To learn more details about export function, please see the IHS user manual (see chapter
6.4.4).

7.6 Configuration of primary and secondary contacts for supplier (optional)
Supplier contacts can be flagged either as primary (only one user) or secondary (multiple users).

These contacts can be then used for automatic selection of the contact and for automatic population of
the CC email recipients for the SPM request emails.

To define primary and/or secondary contacts, company master data in iPCA needs to be opened by
navigation to the menu “Extras > Master data > Companies / legal units / contacts”. The required
company needs to be searched and edited by its selection in the result list and click on the “Edit” button.

PLEASE NOTE: Only user with activated permission “IHS_CONTACT_MANAGEMENT_EDIT” can manage
flagging supplier contacts as primary or secondary.
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o Management of IH5 Company, IMDS Organization Unit, Legal Unit, Country, Region, Crganization @

| Contactsél

Contact Person Phone MNumber: Search Reset

B

Mailbox Org. Unit Mame [ID"

Department

Phone Mumber |Fax Number

Username

< |

B

First Marmne:
Last Mame:
Phone Mumber:
Fax Mumber:
Email:

Corrected e-mail:

Department:

Mailbox:

Username:
[C]Iarn aware that the data protection regulations of the GDPR must be observed when using this application.
() Primary Contact

Pricrity Flag: () Secondary Contact

@ Standard Contact

Please note that the change made will be applied to all cpen requests where this contact is used.

Figure 35 Contacttabinthe Company management panel

7.7 Configuration parameters

To manage SPM configuration parameters, management panel needs be opened by navigation to the
menu “Extras > Management” and “Configuration” tab needs to be activated.

Wished configuration parameter can be found easily by entering its name into the “Key” search field and
click on the “Search” button.

Configuration parameter name Supported values and their meanining Comment

Defines if the type of the datasheet setin See

SPM_MDS_MATCHING_IGNORE_TYPE the SPM request and type of the MDS must  chapter
be the same to match both togetherornot: 8.1
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Configuration parameter name

Supported values and their meanining Comment

SPM_MDS_MATCHING_PART_NUMBER_
MANIPULATION

SPM_MDS_MATCHING_USE_COMPLEX_PART_
NUMBER_MATCH

SPM_MDS_MATCHING_SUPPLIER_PREFIX

SPM_MDS_MATCHING_SUPPLIER_SUFFIX

61

e TRUE (the type of the datasheet setin
the SPM request and type of the MDS
must be the same to match both
together)

e FALSE (the type of the datasheet setin
the SPM request and type of the MDS is
ignored for matching)

Default value is FALSE.

Defines rules for part number manipulation
from SPM request before the matching to

MDS is done.
Any valid and reasonable REGEXP
. . See
expression can be defined as a value.
chapter
Default valueis *.* which means that no &
manipulation is done.
And combinations which are separated by a
semicolon.
Defines if the SPM request - IMDS
Datasheet matching is using part number
wildcard approach or not:
e TRUE (SPM request - IMDS Datasheet
matching will be using complex part See
number manipulation) chapter
e FALSE (SPMrequest - IMDS Datasheet 8.1
matching will not be using complex part
number manipulation)
Default value is FALSE.
Defines the prefix in the supplier code set in
the recipient data page of the IMDS
datasheet.
See
Any value representing the prefix to be chapter
considered when matching can be defined 8.1
asavalue.
Default value is “”.
Defines the length of the suffixin the See
supplier code setin therecipient data page = chapter
of the IMDS datasheet. 8.1
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Configuration parameter name

Comment

Supported values and their meanining

SPM_MDS_MATCHING_USE_COMPLEX_
SUPPLIER_MATCH

SPM_FORCE_ONLINE_REQUEST

SPM_SEARCH_DEFAULT_INCOMPLETE_ONLY

62

Any number representing the length suffix
to be considered when matching can be
defined as a value.

Default valueis 0.

Defines if the supplier set in the SPM
request and supplier of the MDS must be
the same to match both together or not:
e TRUE (SPM request - IMDS Datasheet
matching will be using complex supplier  See
matching) chapter
e FALSE (SPM request - IMDS Datasheet 8.1
matching will not be using complex
supplier matching)

Default value is FALSE.

Defines if the “Save & Send Email” button
the SPM request and “Save email” button in
the SPM panel are enabled or disabled in
case the SPM request in state “IMDS
supplier and contact person assigned” is
loaded/selected:

e TRUE (buttons are enabled in case the (S;r?: ter
SPM request in state “IMDS supplier and 5 2% and
contact person assigned” is clzla.pter
loaded/selected) 6.3.7

e FALSE (button is disabled in case the -
SPM request in state “IMDS supplier and
contact person assigned“ is
loaded/selected)

Default value is FALSE.

Defines if the “only incomplete” checkbox in

the SPM search panel is checked by default

or not: See
e TRUE (checkbox is checked by default) chabter
e FALSE (checkbox is unchecked by 6 1P

default)

Default value is TRUE.
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8 SPM workflows

8.1 Matching with IMDS datasheet
After the daily download received IMDS datasheets can be automatically matched with opened SPM

requests.

The criteria for automatic matching are as detailed below:

e Part number in the IMDS datasheet and part number in the SPM request are the same

This matching criterion cannot be deactivated, but the post-processing (or manipulation) of the
part numberin the IMDS datasheet before the matching is done can be activated by setting

o

the value of the configuration parameter
SPM_MDS_MATCHING_USE_COMPLEX_PART_NUMBER_MATCH to TRUE (see chapter
7.7 for more details).

and by setting the value of the configuration parameter
SPM_MDS_MATCHING_PART_NUMBER_MANIPULATION (see chapter 7.7 for more
details) to any valid regular expression as per the requirements. For example, if this is
set to value ".§10% then first 10 characters from the part number in the IMDS
datasheet are considered for matching process.

e Supplier of the IMDS datasheet and supplier in the SPM request are from the same company (not
necessarily from the same organization unit)

This matching criterion cannot be deactivated, but additional matching loop by using the supplier
code can be activated by setting the value of the configuration parameter
SPM_MDS_MATCHING_USE_COMPLEX_SUPPLIER_MATCH to TRUE (see chapter 7.7 for more
details).. Then it is checked if the supplier code set in the IMDS datasheet is also set for any
company in iPCA (“Supplier/Customer Codes” field in the panel for management of the company).
If yes, the IMDS datasheet is matched with open SPM request.

Additionally, the post-processing (or manipulation) of the supplier code in the IMDS datasheet can
be activated by setting

@)

the value of the configuration parameter SPM_MDS_MATCHING_SUPPLIER_PREFIX
(see chapter 7.7 for more details) to any value as per the requirements. For example, if
thisis set to value A1234 then this string is always cut from the supplier numberin the
IMDS datasheet, so it is not considered for matching process.

and/or the value of the configuration parameter
SPM_MDS_MATCHING_SUPPLIER_SUFFIX (see chapter 7.7 for more details) to any
number as per the requirements. For example, if this is set to value 2 then last two
characters are cut from the supplier number in the IMDS datasheet, so it is not
considered for matching process.

e Type of the IMDS datasheet and type in the SPM request are the same

This matching criterion can be deactivated by setting the configuration parameter
SPM_MDS_MATCHING_IGNORE_TYPE to value FALSE (see chapter 7.7 for more details).
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8.2 Emails for SPM requests

Communication of the SPM request to the suppliers is done mainly via email.

Depending on the configuration of the SPM and depending on the status of the SPM requests, the
different types of emails can be sent.

8.2.1 Email grouping

Depending on the configuration an email for the SPM request(s) can be sent:

For a single SPM request

One email is sent for each SPM request.
This email is sent by default.

For a group of SPM request

One email is sent for group of SPM request(s) cumulated based on the recipient email address set
in the SPM request and attached document(s) (if any).

This email is sentin case that a bulk email feature is enabled in the SPM Parameters panel by
checking the “Bulk Email” checkbox.

This email is generated every n-hours (as per value set in the “Bulk Email Interval” field in the SPM
Parameters panel).

8.2.2 Email types

Depending on the status and due date of the SPM request, activation status of individual email features
and other variables, different types of emails can be sent for SPM request(s):
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Initial email

This email is sent upon click on the “Save & Send Email” or “Save & Send Email/ Online” buttons in
the SPM request panel or by click on “Send email” button in the SPM search panel and its content
is as per below tables.

Value from “Email Subject” field from SPM parameters language tab extended
with “ [ Part no:x - Name:y ]” where

e xisvalue from “Part-No.” field from SPM request

e yisvalue from “Description” field from SPM request

Subject

Value from “Email Header” field from SPM parameters language tab.

General submission details from SPM request.

Body Recipient details from SPM request (all or only fields populated in SPM request,
depending on the configuration of “Use only filled recipient data in email”
setting in the SPM parameters general tab.

Value from “Email Footer” field from SPM parameters language tab.
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To: Value from “Email address” or “Corrected Email” field from the SPM request
Cc: Value from “Email address/es (CC)” field from the SPM request

Recipient(s)

Table 4 Details of the initial SPM email (single)

Email element Source

Subject Value from “Email Subject” field from SPM parameters language tab

Value from “Bulk Email Header” field from SPM parameters language tab.
Value from “Email Footer” field from SPM parameters language tab.
Body
Attachment in XLSX file format listing details from all SPM requests included in
the particular bulk email.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table5 Details of theinitial SPM email (bulk)

e Friendly reminder email
This email is sent automatically in case that a friendly reminder feature is enabled in the SPM
Parameters panel by checking the “Friendly Reminder” checkbox.
It is sent for the first-time n-days (as per value set in the “Friendly Reminder Period” field in the
SPM Parameters panel) after the initial SPM email was sent for the request and is sent every n-
days until the datasheet is received or until the due date set in the SPM request is reached.
Its content is as per below tables.

Value from “Email Subject” field from SPM parameters language tab extended
with “[ Part no:x - Name:y ]” where

e xisvalue from “Part-No.” field from SPM request

e yisvalue from “Description” field from SPM request

Subject

Value from “Friendly Reminder Header” field from SPM parameters language
Body tab.
Text of the last send email for the particular SPM request.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table 6 Details of the friendly reminder SPM email (single)
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Subject Value from “Email Subject” field from SPM parameters language tab.

Value from “Bulk Friendly Reminder Email Header” field from SPM parameters
Body language tab.
Text of the last send email for the particular SPM request.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table7 Details of the friendly reminder SPM email (bulk)

e Reminder email

This email is sent automatically in case that a reminder feature is enabled in the SPM Parameters
panel by checking the “Reminder” checkbox.

Itis sent for the first-time n-days (as per value set in the “Reminder Period” field in the SPM
Parameters panel) after the due date set in the SPM request has passed and is sent every n-days
until the datasheet is received or the request is cancelled, inactivated, deleted or the reminders
are suspended in the SPM request.

Its content is as per below tables.

Email element Source

Value from “Email Subject” field from SPM parameters language tab extended
with “ [ Part no:x - Name:y ]” where

Subject e xisvalue from “Part-No.” field from SPM request
e yisvalue from “Description” field from SPM request
Tl Value from “Reminder Header” field from SPM parameters language tab.

Text of the last send email for the particular SPM request.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table8 Details of the reminder SPM email (single)

Email element Source

Subject Value from “Email Subject” field from SPM parameters language tab.

Value from “Bulk Reminder Email Header” field from SPM parameters language
Body tab.
Text of the last send email for the particular SPM request.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table9 Details of the reminder SPM email (bulk)
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Escation email

This email is sent automatically in case that an escalation feature is enabled in the SPM
Parameters panel by checking the “Escalation” checkbox.

Itis sent only each time together with n-th (as per value set in the “Escalation Trigger” field in the
SPM Parameters panel) reminder and is sent together with the reminder email every n-days until
the datasheet is received or until the datasheet is received or the request is cancelled, inactivated,
deleted or the reminders are suspended in the SPM request.

This email cannot be sent as a bulk email.

Its content is as per below table.

Value from “Email Subject” field from SPM parameters language tab extended
with “[ Part no:x - Name:y ]” where

Subject e xisvalue from “Part-No.” field from SPM request
e yisvalue from “Description” field from SPM request
Value from “Escalation Header” field from SPM parameters language tab.
Body
Text of the last send email for the particular SPM request.
Depends on if the project is set for SPM request and if the project has the
escalation receiver set or not:
e SPMrequest without project or with project without escalation receiver
set
To: Value set in the “Escalation Receiver” field in the SPM Parameters
Recipient(s) panel
Cc: None

e SPMrequest with project with escalation receiver set

To: Value set in the “Email Escalation:” field in the project linked to the
SPM request
Cc: None

Table 10 Details of the escalation SPM email (single)

Inactivation email

This email is sent automatically in case that an inactivation email is enabled in the SPM
Parameters panel by checking the “Send email about SPM request inactivation” checkbox.
Itissent only one time after the SPM request has been deactivated.

This email cannot be sent as a bulk email.

Its content is as per below table.

Email element Source

Subject Value from “Inactivation Subject” field from SPM parameters language taby is
Body Value from “Inactivation Header” field from SPM parameters language tab.
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Value from “Email Footer” field from SPM parameters language tab.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table 11 Details of the inactivation SPM email (single)

e Closure email
This email is sent automatically in case that a closure email is enabled in the SPM Parameters
panel by checking the “Send email about SPM request closure (Assign MDS):” checkbox.
Itissent only one time after the SPM request has been closed (status changed to “Assigned MDS
accepted”).
This email cannot be sent as a bulk email.
Its content is as per below table.

Email element Source

Subject Value from “Closure Subject” field from SPM parameters language tabyis

Value from “Closure Header” field from SPM parameters language tab.

LY Value from “Email Footer” field from SPM parameters language tab.

To: Value from “Email address” or “Corrected Email” field from the SPM request

Recipient(s) Cc: Value from “Email address/es (CC)” field from the SPM request

Table12 Details of the closure SPM email (single)

8.3 Automatic update of contacts in open SPM requests

The SPM request is assigned to the contact, which the primary recipient of the email communication for
the request. Its email address is set in the “Email address” field or in the “Corrected Email” field,
depending on the type of the user and if its email address was adjusted internally in iPCA.

Optionally, the SPM request emails can be sent also to additional recipients set in the “Email address/es
(CC)” field in the SPM request.

For SPM request, IMDS contacts as well as contacts created in iPCA (are of the type “IHS”), can be used.

These contacts can be modified or deleted. For more details see Table 13 below.
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Possible actions

In IMDS (reflected in iPCA via IMDS daily download)
e Change (e.g. email address, last name, etc)

e Delete
IniPCA (via company & contact management)
IMDS e Setvaluein the “Corrected e-mail” field

e Setcontact priority flag as (if the featureis licensed)
o Primarycontact
o Secondary contact
o Standard contact

IniPCA (via company & contact management)

Create

Change value in the “Email” field

Delete

Set contact priority flag as (if the feature is licensed)
o Primary contact
o Secondary contact
o Standard contact

IHS

Table13 List of possible actions on contacts

In case the IMDS or IHS contact is being edited in iPCA company & contact management, the notification
is displayed informing user about the fact that the change made will be applied to all open requests
where this contact is used (see Figure 36).

I am aware that the data protection regulations of the GDPR must be observed when using this application.
() Primary Contact

Pricnty Flag: () Secondary Contact
@ Standard Contact

Please note that the change made will be applied to all cpen requests where this contact is used.

Mew Edit Delete Save | [ Cancel

Figure 36 Notification shown when editing the contact

In case the IHS contact is being deleted in iPCA company & contact management, the notification is
displayed informing user about the fact that the change made will be applied to all open requests where
this contact is used (see Figure 37).
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Confirm deletion

Please note that the change made will be applied to all open requests where this contact is used.

=

Yes | ’ Mo

Figure 37 Notification shown when deleting the contact

It can happen that edited or deleted contact is used in an open SPM request, so the contact assignment
in the SPM request needs to be updated. This update is done automatically by the background process
that is started every 5 minutes and it follows the matrix details in the Table 14 and Table 15 below.

Change

performed

Priority
Flag

Action

IMDS -contact
is deleted

iPCA - contact’s
email address is
changed
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Standard

Primary

Secondary

Standard

Primary

Secondary

If the email address is found in "Email address" field:
e theemail address in the "Email address" field and contact
assigned in the "Contact person" field are deleted
e thestatusof the SPMrequestis changed to
"IMDS Supplier Assigned"

If the email address is found "Email address/es (CC)" field:
e theemail addressin the "Email address/es (CC)" field is
deleted
e thestatusof the SPM request is not changed

The email address in the "Email address" field and contact
assigned in the "Contact person" field are deleted.

The status of the SPM request is changed to "IMDS Supplier
Assigned".

The email address in the "Email address/es (CC)" field is deleted.

The status of the SPM request is not changed.

If the email address is found in "Email address" field:
e The email address in the "Email address" field is changed
e Thestatus of the SPM request is not changed

If the email address is found "Email address/es (CC)" field:
e The email address in the "Email address/es (CC)" field is
changed
e Thestatus of the SPM request is not changed

The email address in the "Email address" field is changed.

The status of the SPM request is not changed.
The email address in the "Email address/es (CC)" field is changed.
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Change Priority
performed Flag

iPCA - Corrected
email is set

iPCA - Priority
flag set to
“Primary
Contact”

iPCA - Priority
flag set to
“Secondary
Contact”

iPCA - Priority
flag set to
“Standard

Standard

Primary

Secondary

Standard

Secondary

Standard

Primary

Primary

The status of the SPM request is not changed.

If the email address is found in "Email address" field:
e The email address in the "Email address" field is changed
e Thestatus of the SPMrequest is not changed

If the email address is found "Email address/es (CC)" field:
e The email address in the "Email address/es (CC)" field is
changed.
e Thestatus of the SPM request is not changed.

The email address in the "Email address" field is changed.

The status of the SPM request is not changed.
The email address in the "Email address/es (CC)" field is changed.

The status of the SPM request is not changed.
If the SPM request is in the status = "IMDS Supplier Assigned"
e theemail addressis inserted into the "Email address" field
and contact is inserted into the "Contact person" field
e thestatusof the SPMrequestis changed to
“IMDS Supplier and contact person assigned"

If the SPM request isin the status > "IMDS Supplier Assigned"
e the email address in the "Email address" field and contact
assigned in the "Contact person" field are changed
e the email address is removed from the "Email address/es
(CC)" field
e Thestatus of the SPM request is not changed
If the SPM request is in the status = "IMDS Supplier Assigned"
e theemail addressisinsertedinto the " Email address/es
(CC)" field
e thestatus of the SPM request is not changed

If the SPM request is in the status > "IMDS Supplier Assigned"
e theemail address in the "Email address" field and contact
assigned in the "Contact person" field are removed
e theemail addressisinserted into the "Email address/es
(CC)" field in the SPM request
e thestatusof the SPM request is not changed
If the SPM request is in the status = "IMDS Supplier Assigned"
e thecontactsare not changed
e thestatusof the SPM request is not changed
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Change Priority
performed Flag

Contact”

If the SPM request is in the status > "IMDS Supplier Assigned"
e theemail address in the "Email address" field and contact
assigned in the "Contact person" field are removed
e thestatusof the SPM request is not changed

If the SPM request isin the status = "IMDS Supplier Assigned"
e theemail address is removed from the "Email address/es
(CC)" field
e thestatusof the SPM request is not changed
Secondary
If the SPM request isin the status > "IMDS Supplier Assigned"
e theemail address is removed from the "Email address/es
(CC)" field
e thestatusof the SPM requestis not changed

Table 14 Matrix of SPM request updates triggered by IMDS contact changes

Change Priority

performed Flag Action

If the email address is found in "Email address" field:
e theemail address in the "Email address" field and contact
assigned in the "Contact person" field are deleted
e thestatusof the SPMrequestis changed to
Standard IMDS Supplier Assigned
If the email address is found "Email address/es (CC)" field:
e theemail addressin the "Email address/es (CC)" field is
iPCA —contact is deleted
deleted e thestatusof the SPM request is not changed
The email address in the "Email address" field and contact
assigned in the "Contact person" field are deleted.
Primary
The status of the SPM request is changed to "IMDS Supplier
Assigned".

The email address in the "Email address/es (CC)" field is deleted.
Secondary
The status of the SPM request is not changed.

If the email address is found in "Email address" field:
e The email address in the "Email address" field is changed

IELS ~ EETIEEE S e Thestatus of the SPM request is not changed

email addressis  Standard

changed If the email address is found "Email address/es (CC)" field:

e The email address in the "Email address/es (CC)" field is
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Change Priority
performed Flag

Primary
Secondary
iPCA - other Standard
contact’s detail ~ Primary
is changed Secondary
Standard
iPCA - Priority
flag set to
“Primary
Contact”
Secondary
Standard
iPCA - Priority
flag set to
“Secondary
Contact”
Primary
iPCA - Priority
flag set to Primar
“Standard y
Contact”

changed
e Thestatus of the SPM request is not changed

The email address in the "Email address" field is changed.

The status of the SPM request is not changed.
The email address in the "Email address/es (CC)" field is changed.

The status of the SPM request is not changed.
No updateis done.
No update is done.
No updateis done.
If the SPM request is in the status = "IMDS Supplier Assigned"
e theemail addressis inserted into the "Email address" field
and contact is inserted into the "Contact person" field
e thestatusof the SPMrequest is changed to
"IMDS Supplier and contact person assigned"

If the SPM request is in the status > "IMDS Supplier Assigned"
e the email address in the "Email address" field and contact
assigned in the "Contact person" field are changed
e theemail addressis removed from the "Email address/es
(CC)" field
e Thestatus of the SPM request is not changed
If the SPM request is in the status = "IMDS Supplier Assigned"
e theemail addressisinserted into the " Email address/es
(CC)" field
e thestatusof the SPM request is not changed

If the SPM request is in the status > "IMDS Supplier Assigned"
e the email address in the "Email address" field and contact
assigned in the "Contact person" field are removed
e theemail addressisinserted into the "Email address/es
(CC)" field in the SPM request
e thestatusof the SPM request is not changed
If the SPM request is in the status = "IMDS Supplier Assigned"
e thecontacts are not changed
e thestatusof the SPM request is not changed

If the SPM request is in the status > "IMDS Supplier Assigned"
e theemail addressin the "Email address" field and contact

assigned in the "Contact person" field are removed



iPCA SPM V14.05 onwards iPoint

Change Priority
performed Flag

e thestatusof the SPM request is not changed

If the SPM request isin the status = "IMDS Supplier Assigned"
e theemail address is removed from the "Email address/es
(CC)" field
e thestatusof the SPM request is not changed

Secondary
If the SPM request isin the status > "IMDS Supplier Assigned"
e theemail address is removed from the "Email address/es

(CC)" field
e thestatusof the SPM requestis not changed

Table15 Matrix of SPM request updates triggered by SAM-M contact changes
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Version

4.0

4.02.002

51

5.1.006
5.2
5.4

6.1

7.5
9.0

9.05
9.09
10.12.000

10.12.000

10.25.000

11.00

11.00

11.07

Date

18.05.2006

24.07.2006

25.05.2007

15.06.2007
13.08.2007
11.01.2007

25.10.2008

15.10.2009
15.10.2012

22.05.2013
02.08.2013
11.07.2014

22.06.2015

13.08.2015

21.09.2015

12.02.2015

23.02.2016

Description

Complete revision
Added extension to Rel. 4.0
Introduction to change history

Login screenshot changed

New symbols for easier recognition of the different status for
request status, due date and IMDS state

Availability of the full functionality in iPCA/IHS

Project specific email address for escalation

More flexible email sender address

New status "IMDS request rejected by supplier"

New search criteria: ID, Requestor and Sender

Part Number Check before save a new request
Change toiPCA

Changes forrelease 7.5

Changes forrelease 9.0
Added MNS support

Reworked SPM with multilanguage support, extended search
mask, result list and modified SPM request form

Complete rework of the user manual

Minor updates and improvements of the text
Some figures updated to match actual status

Minor improvements and fixes of typos
Migration of the user manual to new iPoint style

Updated big number of figures (due to change of the iPoint logo
iniPCA)
Fixed some typos

Updated some figures and text based on the change of the
wording (Development sample report MDS -> Preliminary MDS)

Added a hint about automatic deletion of the IMDS online
request in case of deletion of SPM request which was uploaded to
the IMDS online system (chapter 6.3.3)

Modified status “Int. supplier assigned” to “IMDS supplier
assigned”in Table 1

Added information about which attributes must be the samein
the received MDS and SPM request in order to automatically to
link them together

Added details about new configuration parameter
“SPM_FORCE_ONLINE_REQUEST” (chapter 5.2.3)

Specified SPM request states when the buttons “Save & Send
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11.11

11.12

12.00

12.03

12.05

29.06.2016

20.07.2016

19.09.2016

07.11.2016

15.12.2016

Email” and “Save & Send Email/ Online” buttons are active
(chapter5.2.3)

Added details about new configuration parameter
“SPM_FORCE_ONLINE_REQUEST” and about SPM request states
when the button “Send Email” is active (chapter 6.3.7)

Specified SPM request states when the button “Send Online Req.”
buttons is active (chapter 6.3.8)

Modified status “Int. supplier assigned” to “IMDS supplier
assigned” (chapter 6.1)

Added reference to the notification email on SPM request closure
(chapter 6.3.5)

Updated Figure 22 to reflect addition of two new email events for
SPM (chapter7.1)

Added precision about email address used as a sender of email in
case the “Email Sender Type”is set to “Requestor” (chapter
7.1.1.1)

Added description about two new email events for SPM request
(chapter7.1.1.1)

Added description about new email configurations for two new
email events for SPM request (chapter7.1.1.2)

Added note about possibility of export of result list to the XLSX
format

Updated Figure 1 (chapter 5.2)

Updated Figure 7 and renamed “Supplier no.” to “Supplier Code”
(chapter5.2.1.3)

Added the button name “Show” and details when this button
label is displayed (chapters 6.3 and 6.3.1)

Renamed “Supplier no.” to “Supplier Code” (chapter 7.1.1.2)

Reordered subchapters in chapter 6.3
Improved and fixed the description for the “Show” button
(chapter 6.3.1)

Added details about possibility to assign MDS of different type
than MDS type set in the SPM request (chapter 6.3.5)
Completely reworked chapter 7.4

Added information about logging activation of suspend reminder
in the SPM request history (chapter 5.2.1.4)

Updated Figure 23 (chapter7.1)

Improved descriptions for some of the items and descriptions of
escalation and bulk email headers removed (chapter 7.1.1.1)
Added descriptions of escalation and bulk email headers (chapter
7.1.1.2)

Updated Figure 24 (chapter7.1.1.1.1)
Improved description in chapter 0
Improved descriptionin chapter7.1.1.1.1.2
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12.16

12.19

13.00

13.22

13.25

14.01

14.03

14.05

06.09.2017

16.08.2017

15.12.2017

08.10.2018

14.01.2019

10.04.2019

28.05.2019

10.07.2019

Added details relevant for optional SPM Priority Contact Module
(chapter5.2.1.2)

Added chapter5.4

Updated permission name (chapter 7.2)

Added chapter 7.6

Updated Figure 23 (chapter7.1)
Added details of new checkboxes for control of automatic
assignment of primary and secondary contact(s) (chapter7.1.1.1)

Bulk SPM email is now available to all SPM customers
Updated Figure 16 and updated order of the search criteria
accordingly (chapter6.1)

Changed “Language for correspondence” to “Communication
language” (chapter 7.3.1)

Changed “Language for correspondence” to “Communication
language” (chapter 7.3.2)

Updated Figure 35 (chapter 7.6)

Updated Figure 1 (chapter 5.2)
Updated Figure 8 (chapter 5.2.1.4)
Updated Figure 23 (chapter 7.1)
Added chapter 8

Updated names of permissions required to access “Projects”
master data panel (chapter 7.4)

Updated names of permissions required to access “Projects”
master data panel (chapter 7.5)

Extended description of chapter 7.5.3.5

Added “Remark” as a new search criterion (chapter 6.1)
Updated Figure 16 (chapter 6)

Added hint about usage of characters that are not allowed by the
IMDS online system (chapter 5.2.1)

Added details about the PDM SPM configuration parameter panel
(chapter7.2)

Reworked and reduced chapter 4

Updated Figure 1 (chapter 5.2)

Updated Figure 7 and added the “Supplier Site Code” field
(chapter5.2.1.3)

Updated Figure 16 (chapter 6)

Added description for all result columns (chapter 6.2)
Added the “Supplier Site Code” field (chapter7.1.1.2)
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